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CHAPTER 1

Welcome
Approximate Time: 1 hour, 20 minutes

Welcome to the Flare eLearning Tutorial—Advanced. Before working through this tutorial, we
recommend you first complete the basic tutorial.

n Tutorial Goal Learning how to create an interactive eLearning course via a series of learning
blocks (topics). The course can be tracked through integration with an external learning
management system.

n Key Concepts Creating questions, multiple choice and multiple response answers, and other
eLearning elements; adding a navigation toolbar; single-sourcing content; adjusting skins and
styles; and producing online and print-based output.
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CHAPTER 2

Creating a Project From a
Template
To start, let's create a new project based on Flare's Austin template.
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How to Create a New Project From a
Template
1. Select File > New Project. The Start New Project Wizard opens.

2. In the Project name field, give your project any name you want.

3. (Optional) In the Project folder field, you can enter a location where you want to save your
project. By default, projects are saved in your Documents > My Projects folder.

4. Click Next.

5. Under Factory Templates, expand the Tutorials folder. Select the Austin template.

6. Click Next.

7. For branding, keep the default settings. (This is where you could customize your project's
look with branding, such as colors and logo.) Click Next.

8. Click Finish. The project is created and loaded into Flare.
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CHAPTER 3

Creating eLearning Content
The project already has several topics, which we will use as learning blocks as part of the course.
We also need some additional learning blocks containing questions and answers. In other words,
our eLearning course will consist of several topics that learners can navigate through; some of the
topics will simply display information, while others will have interactive question sections and
feedback.

This chapter discusses the following:

How to Add Folders 11

How to Add Topic Files 12

How to Add Content to the Knowledge Check Topics 14

How to Add Content to the Test Topics 26
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How to Add Folders
1. First, let's create some folders to organize the new topics that we'll be adding. In the Content

Explorer, right-click the root Content folder, and from the context menu select New > Folder.

2. Type Knowledge-Check-Topics as the name of the folder, and press ENTER.

3. Repeat these steps to add another folder named Test-Topics.

Knowledge check topics consist of information that is relayed to a learner, but the learning
exercise is not formally graded. You have the option to track if the learner completed the
course or not. In this tutorial, we'll add a couple of knowledge check topics in the middle of
the course.

Test topics consist of quiz questions with specific answers that are graded. A quiz is a basic
way to determine a level of knowledge. It can reveal gaps in knowledge. We'll add some test
topics at the end of the course.

Either knowledge checks or test results can be tracked by integrating them with an external
learning management system (LMS). We'll go over this more later (see "Creating and
Developing Targets" on page 71 and "Accessing the LMS Package" on page 142).

NOTE On the next page of this tutorial, we have included an optional knowledge
check.
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How to Add Topic Files
1. In the Content Explorer, right-click the Knowledge-Check-Topics folder, and from the context

menu select New > Topic. The Add File dialog opens.

2. Under the Factory Templates, select the NewTopic.htm template.

3. In the File Name field, type First Knowledge Check as the name for the first new topic.

4. Click Add. The topic is added to the Content Explorer, and the XML Editor opens to the right,
displaying the topic.

5. Add another topic to the same folder, and name it Second Knowledge Check.
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6. Add a third topic in that folder and name it The End.

Here is what you should see.

7. Repeat the steps above to add the following new topics under the Test Topics folder:

Quiz

Question 1

Question 2

Here is what you should see.
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How to Add Content to the Knowledge
Check Topics
1. Open the First Knowledge Check.htm topic. (You can either double-click the topic file in the

Content Explorer, or select the tab at the top of the editor area.)

2. Delete the placeholder text under the heading so that it's an empty paragraph.

3. In the eLearning ribbon at the top of Flare, click Multiple Choice (with the circles).

4. For the question, copy and paste this text:

What is the capital of Texas?

5. For the first answer, enter Waterloo, and press ENTER.

6. For the second answer, enter San Antonio, and press ENTER.

7. For the third answer, enter Austin. This time, do not press ENTER, since this is the last
answer for the question.
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8. Click the circle next to Austin, since that is the correct answer.

9. Now let's add some feedback, depending on whether the learner chooses the correct or
incorrect answer. In the eLearning ribbon click Add Feedback.

TIP You can also right-click a MadCap structure bar to the left of the content to add
feedback (or perform other eLearning tasks).

10. Replace the first line of text with this:

Correct. The capital of Texas is Austin.
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11. Replace the second line of text with this:

Incorrect. The capital of Texas is Austin.
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12. Next, we need a button so that learners can submit their answer. So in the eLearning ribbon
click Add Submit Button. A button with the word "Submit" is added at the end.
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13. We're going to add another question section after this one. But this time, we will allow
multiple selections. To begin, click after the Submit button in the topic, so that you see the
flashing horizontal cursor under it.

14. Press ENTER.

15. In the eLearning ribbon, click Multiple Response (with the squares).

16. For the question, copy and paste this text:

What kind of weather is likely in Austin? (Select all that apply.)
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17. Add the following three responses, pressing ENTER after the first and second answers, but
not the third:

Long hot summers

Snowfall in autumn

Short mild winters

18. Click the first and third check boxes as the correct answers.
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19. Use the Add Feedback button to provide the following:

Correct. Austin's climate is considered humid subtropical.

Incorrect. Austin experiences long hot summers and short mild
winters.

Then click Add Submit Button.

TIP You can also start by selecting just Add Submit Button. This will add not only the
placeholder feedback text, but the Submit button as well.

20. Click to save your work.
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21. Open the Second Knowledge Check.htm topic. In the same way as above, add two question
sections. Copy and paste the following text (a multiple choice first, then a multiple response),
add submit buttons, and set the correct answers as shown in the image below.

First Question Section

What is Austin known as?

"The Live Music Capital of the World"

"Best Barbecue in the World"

"Center for Urban Bat Colonies"

Correct. Even though BBQ and urban bats are found in Austin, the
city is known for its vibrant music scene. Its official slogan is
"The Live Music Capital of the World."

Incorrect. Austin has a vibrant music scene, and is officially known
as "The Live Music Capital of the World."

Second Question Section

What music events are in Austin? (Select all that apply.)

Lollapalooza

Austin City Limits

South by Southwest

Correct. Austin is home to the SXSW music festival and the ACL music
festival.

Incorrect. Austin hosts South by Southwest and Austin City Limits.
Chicago hosts the Lollapalooza music festival.
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22. Notice the small markers indicating that both of these questions are required, just as they are
in the First Knowledge Check.

This means that learners must answer the question in order to use the navigation button
(which we'll add soon) to proceed to the next page of the course. Let's make both of the
questions in the Second Knowledge Check optional, which means learners do not have to
answer them before moving to the next page. In the eLearning ribbon, click Question
Properties.

NOTE Markers are shown only when you're working in the XML Editor in Flare; they
are not shown in the output. To enable or disable markers, go to the local toolbar at
the top of the XML Editor, click the Show Tags drop-down field, and then select
Markers.
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23. Click any of the content for the first question section (i.e., the question itself, any of the
answers, the feedback, the submit button). The Question Properties window pane to the right
contains some fields that reflect the properties for that element. Even as you click on
different parts of that question section, you will see the values for the fields changing (e.g.,
click the different answers to see which is set as the correct one in the window pane). We're
not going to use or change most of the options in the window pane for this tutorial (for details
about the various options, see the online Help). But let's change one thing. From the Required
for Navigation drop-down, select False. This changes the marker for the question to
"Optional."
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NOTE In addition to setting questions as required (or not) individually using the
Question Properties window pane, you can set it on the MadCap|multipleChoice style
in your stylesheet. For example, if you don't want any of your questions to be
required, setting the mc-required-question property (located in the Unclassified
section of the Stylesheet Editor ) on this style to false can save you a lot of time, so
that you don't have to set each question one at a time from the Question Properties
window pane.

24. Do the same for the second question section in the topic. Now both questions are optional.

25. Click to save your work.

26. Open the topic called The End.htm. We're not going to add any question sections to this topic.
We're simply going to use it to show that the learner has reached the end of the course. Paste
the following text into the topic, replacing the placeholder text:

This is the end of the course. Thanks for learning all about the
city of Austin, Texas.

27. Click to save your work.

NOTE In this tutorial we are selecting options in the eLearning ribbon to add placeholder
content for questions and answers. However, you also have the option of converting
existing content into question sections. Just use your mouse to select the content and then
select Multiple Choice or Multiple Response in the eLearning toolbar. The first paragraph of
your selection will become the question and each paragraph under it will be an answer.
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How to Add Content to the Test
Topics
1. Open the topic called Quiz.htm. Again, we're not going to add any question sections to this

topic. It's purpose is simply to inform people that they are at the beginning of the quiz. Paste
the following into it, replacing the placeholder text:

This is the start of a short quiz to test your knowledge about
Austin. Navigate to the next topic to begin the gradable portion of
the course.

2. Click to save your work.

3. Open the Question 1.htm topic.

4. Delete the placeholder text under the heading so that it's an empty paragraph.

5. In the eLearning ribbon, click Multiple Choice (with the circles).

6. For the question, copy and paste this text:

Who is known as the "Father of Texas"?

7. Add the following three answers:

Stone Cold Steve Austin

Stephen F. Austin

Lyndon Johnson
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8. Click the circle next to Stephen F. Austin, since that is the correct answer.

9. Click to save your work.

We're not adding feedback or a Submit button this time, because we don't want learners to
see instant feedback. We could add just feedback without a Submit button, in which case the
feedback content would be shown at the end on the quiz results page. But in this tutorial,
we're going to just let that page show the results, instead of any additional feedback.

10. Open the Question 2.htm topic.

11. Delete the placeholder text under the heading so that it's an empty paragraph.

12. In the eLearning ribbon, click Multiple Response (with the squares).

13. For the question, copy and paste this text:

Which are not official slogans for Austin? (Select all that apply.)
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14. Add the following three answers:

"Best Barbecue in the World"

"The Live Music Capital of the World"

"Center for Urban Bat Colonies"

15. Click the first and third check boxes as the correct answers.

16. Click to save your work.
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CHAPTER 4

Updating the Table of Contents
We have our eLearning topics. Now we need to incorporate them into our table of contents (TOC).

This chapter discusses the following:

How to Add the Knowledge Check Topics to the TOC 30

How to Add the Test Topics to the TOC 33
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How to Add the Knowledge Check
Topics to the TOC
1. In the Project Organizer on the left side of Flare, expand the TOCs folder, and double-click

Online-TOC.

2. In the Content Explorer, expand the Knowledge-Check-Topics folder (if necessary). Then, click
and drag the First Knowledge Check.htm topic into the TOC, placing it between the
Introduction and Attractions entries.
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3. Click and drag the Second Knowledge Check.htm topic into the TOC, placing it between the
Music and Famous Austin Folks entries.
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4. Click and drag the topic called The End.htm into the TOC, placing it after the Famous Austin
Folks entry.

5. Click to save your work.
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How to Add the Test Topics to the
TOC

Test (or quiz) topics in the TOC are unique in that they need to be placed in a special test node. That
is how the system knows that the questions and answers in these topics should be treated as
gradable.

NOTE Keep in mind that you can have only one test node per TOC.

1. In the TOC, make sure the final entry (The End) is selected. Then, in the local toolbar click .

2. Type Quiz as the name for the node, and press ENTER.

3. Select that new node and press F4 on your keyboard to open the Properties dialog.
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4. Select the General tab, and click the Select Topic radio button (even if it's already selected).

5. In the dialog that opens, expand the Test-Topics folder and select Quiz.htm. Then click Open.

6. Back in the Properties dialog, select the eLearning tab.

CHAPTER 4  34



7. There are various options you can select for the quiz (for details about each field, see the
online Help). We're going to leave most of these as they are, but let's tell Flare to switch up
the order of the answers so that they're not the same each time the course is launched.
Select Randomize Test Answers.

8. Click OK. Our Quiz topic is now linked to that node, removing the flag icon next to it.

CHAPTER 4  35



9. In the Content Explorer, click and drag the Question 1.htm and Question 2.htm topics under
that node, so that they are indented. If necessary, you can use the right arrow button ( ) in
the local toolbar to get them positioned. When finished, it should look like this.

10. Click to save your work.
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CHAPTER 5

Creating and Applying Snippets
and Conditions
One of Flare's greatest strengths is its ability to single-source content. This simply means that you
create the content once and reuse it in different ways, rather than doing a lot of rewriting, or
copying and pasting. Single-sourcing content can save you a great deal of time and energy, and
help to maintain consistency.

Two of the most essential features for single-sourcing are snippets and conditions. We're going to
use both of these types of features in the following steps in order to reuse some content. Variables
are also commonly used for single-sourcing; we'll work with variables later in this tutorial.

This chapter discusses the following:

How to Create a Snippet From Existing Content 38

How to Find Text and Insert Snippets 43

How to Add Conditions 47

How to Apply Conditions to Text 49

How to Apply Conditions to TOC Entries 57
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How to Create a Snippet From Existing
Content
1. First, let's create a subfolder to store any snippets that we create. In the Content Explorer,

right-click the Resources folder and select New > Folder. Type Snippets as the name for the
folder and press ENTER.
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NOTE Resources > Snippets is the recommended location for your snippet files, but
you can actually add them anywhere in the Content Explorer that you like. The same
is true of any other resource files (they can be placed anywhere in the Content
Explorer). You can also created nested folders under the Resources folder if you have
many files that you need to organize.

2. Open the First Knowledge Check.htm topic.

3. After the second question, highlight the text (Select all that apply.). Then, from the Home
ribbon at the top of Flare, click Create Snippet.
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4. In the Create Snippet dialog, enter Select-All-That-Apply as the file name for the new
snippet.

5. The rest of the fields are set just as we want. (It's pointing to the correct folder, and we are
replacing the selected content with the new snippet file.) So click Create.
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You should now see brackets (markers) around that text. This signifies that the content is
actually contained in a separate file, located in the new folder you created in the Content
Explorer. Therefore, you cannot edit that text in the topic file anymore; you need to open the
separate snippet file to edit it.

NOTE You can create snippets for any content that is repeated in multiple places.
Use your best judgment for the content where you create snippets. For example, in
this same topic, you can see the words Correct and Incorrect, which are repeated
throughout the course. You can also see that the correct and incorrect text next to
the first instance of these ("The capital of Texas is Austin.") is repeated. Perhaps you
want to turn any of these into snippets. In this tutorial, we're just going to focus on
the one sentence that we've already turned into a snippet. Just know that there are all
kinds of possibilities for creating snippets from content, whether it is just text or
collections of any other types of content (e.g., tables, images, lists).

6. Click to save your work.
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WARNING You can create snippets for entire question sections and reuse them. However,
use caution when doing so, because each question has its own question ID associated with
it, and you do not want the ID to end up inside the snippet. The question ID is necessary for
eLearning tracking. For more information see the Flare online Help.
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How to Find Text and Insert Snippets
Now that we have our snippet, we just need to insert it anywhere that the same content should be
used. In this tutorial, we've already entered that text manually, so we just need to find all the places
where it occurs. We'll use the Find and Replace feature to do that.

1. From the Home ribbon, click Find and Replace.

2. Make sure the Find Text tab is selected at the top of the window pane, and in the Find field
enter (Select all that apply.). And make sure the rest of the options match those in
the following image.
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3. At the bottom of the window pane, click Find All.

The window pane that opens at the bottom of the interface displays three files where the text
is found. One of these is our new snippet, so we don't need to worry about that one. But we
want to open the other two files to replace the text with the snippet.

4. Double-click the row in the Find Results window pane for the Question 2.htm topic.

This opens that topic and highlights the text.

5. In the local toolbar of the XML Editor, click (the face of the button, not the down arrow).
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6. In the dialog, find and select the new snippet that you created, and click OK.

The text is now replaced with the snippet.

7. Click to save your work.

8. Right-click the snippet in the XML Editor, and from the context menu select Copy.

9. In the Find Results window pane at the bottom of Flare, double-click the row for the Second
Knowledge Check.htm topic.
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10. Right-click the highlighted text and select Paste. Now all instances of that text have been
replaced with the snippet. In the future, you can simply insert the snippet wherever you need
to use the same text.

11. Click to save your work.

12. And just to underscore the power of snippets, let's edit the text a little bit. Right-click the
snippet at its location where you inserted it into the Second Knowledge Check topic, and from
the context menu select Open Snippet File.

13. In the snippet file that opens, add the word answers so that it now reads "(Select all answers
that apply.)"

14. Click to save your work.

15. Now open any of the topics where the snippet is inserted, and notice the edited text.
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How to Add Conditions
A condition is a feature that you can apply to certain content or a file so that you can include or
exclude it from a particular output. To start using conditions, the first thing you need to do is add
them to a condition set file.

1. Open the Project Organizer on the left side of Flare.

2. Expand the Conditional Text folder, which is where all condition tags are stored.

3. Double-click Default to open that condition tag set. This type of file can hold many conditions.
And you can create as many condition tag sets as you need in order to organize all of your
conditions. In this tutorial, we're just going to work with the Default condition tag set that is
provided.

4. There are already a handful of conditions in this tag set. You may or may not end up using
some of these, or you can rename them for other purposes if you want. Let's create some
new conditions that we will use specifically for our eLearning content. In the local toolbar,
click .

5. This adds a new row to the condition tag set. Click NewTag so that the text is highlighted,
type CombinationCourseOnly for the name of the tag, and press ENTER. Notice a color is
automatically assigned for that row, but you can click the down arrow and choose a different
color if you want.
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6. Follow these steps again to create new condition rows with the following names:

KnowledgeCheck

KnowledgeCheckOnly

Test

TestOnly

NOTE Instead of "Test" and "TestOnly," you could name the conditions "Quiz" and
"QuizOnly." In fact, in your actual project, you can name conditions anything you
want. Just make sure they're descriptive enough so any writers on your team can
quickly identify the purpose of each condition. You can also use the Comment cell in
the grid to provide information about each condition.

7. Click to save your work.
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How to Apply Conditions to Text
Now let's apply our new conditions to some content areas in the project. Conditions can be applied
to all kinds of content and files, but in this tutorial we're just going to focus on some text, and then
we'll also apply them to some entries in our table of contents (TOC).

1. From the Content Explorer, double-click the Home.htm topic to open it.

2. At the end of the topic, add the following three paragraphs.

There is a knowledge check and a test later in this course.

There are knowledge checks at certain points in the course.
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There is a test at the end of the course.
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3. Let's add one more line of text at the end, which we'll use to begin the course in the online
output. Type START COURSE.
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4. We want to turn this text into a link, so highlight it, and in the local toolbar click .

NOTE In most cases, cross-references are recommended over hyperlinks when
creating links between files in the same project. However, because we want our link
to have some specific text (START COURSE) as opposed to using an automated
formula, we're going to use a hyperlink in this tutorial.

5. In the dialog that opens, make sure the Link to field at the top is set to File in Project. Then,
select the Introduction.htm topic in the area below, and click OK. Now the text is a link, which
is displayed in an orange, underlined format.
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6. Now back to our conditions. We want to mark each of our new four lines of text to be
associated with a different condition. The idea is that the conditioned text will only show up in
certain output. To start, click anywhere in the line of the first paragraph that you added, and in
the Home ribbon click Conditions.
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NOTE You do not need to select all of the text, since we want to apply the condition
to the entire paragraph. If you were to select only a portion of the sentence, the
condition would be applied only that selected text, and not to the whole paragraph.

7. In the Condition Tags dialog, click the check box next to CombinationCourseOnly. Then, click
OK.
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As long as you have markers enabled, you should now see that paragraph shaded in color.
This color won't display in the output; it's simply there in the XML Editor to let you know that a
condition has been applied to the paragraph.
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8. Repeat these steps to apply the following conditions to the other three lines:

Second line: Apply the KnowledgeCheckOnly condition.

Third line: Apply the TestOnly condition.

Fourth line: Apply the ScreenOnly condition.

When you are finished, it should look something like this.

9. Click to save your work.
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How to Apply Conditions to TOC
Entries

Currently, our project has two TOCs—one dedicated to online output, and another for print-based
output. However, there is a lot of flexibility when it comes to TOCs in Flare. You could choose to
create a separate TOC for each output that you generate, including a unique TOC for many different
online outputs. Alternatively, you could create a single TOC to be used for multiple outputs, and
apply conditions to certain entries in the TOC that should be reserved for only some outputs. That's
what we're going to do in this tutorial. In the end, we want to create three different kinds of online
outputs, but we'll use the same TOC for each of those outputs.

So the first thing we need to do is open the TOC and apply some conditions to a few entries within
it.

1. If the TOC is not still open, from the Project Organizer double-click Online-TOC to open it in
the TOC Editor to the right.

CHAPTER 5  57



2. Select the First Knowledge Check entry, and in the local toolbar click .

3. In the Properties dialog, select the Conditional Text tab.

4. Click the check box next to KnowledgeCheck. Then, click OK.
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In the TOC Editor, the square next to that entry shows the color of the condition.

5. Apply that same condition to the Second Knowledge Check entry.

6. Apply the KnowledgeCheckOnly condition to the entry labeled The End.

7. Apply the Test condition to the Quiz test node.

When you're finished, it should look something like this.

8. Click to save your work.

To this point, we've created the conditions and applied them to some areas. But that doesn't mean
we're done yet. We'll finish up our tasks related to conditions later when we create and develop our
targets.
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CHAPTER 6

Adding an eLearning Toolbar
Now that we have our content, let's add an eLearning toolbar so that learners can easily navigate
from one topic to the next, and see their progress while doing so. In fact, if you are viewing this
tutorial online, you can see an eLearning toolbar at the bottom of most topics; we've omitted the
progress bar in our case, but we've included Next and Previous buttons.

There are two parts to adding this toolbar—a proxy and a skin component. The proxy is a
placeholder that we will place where we want the toolbar to be generated and displayed in the
output. The skin component lets us determine what elements will be included in the toolbar and
how the toolbar will look.

This chapter discusses the following:

How to Insert an eLearning Toolbar Into a Template Page 61

How to Add and Edit an eLearning Skin Component 64
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How to Insert an eLearning Toolbar
Into a Template Page

Our online output from this project will consist of a Home page, followed by a series of topics
containing information, knowledge checks, and a quiz. We want our new toolbar to display at the
bottom of all of those topics, except the Home page. The easiest way to add the same content or
look to a lot of topics is to edit the template page associated with those topics. Our project is
already set up with two template pages—one associated specifically with the Home page, and the
other associated with our target (which we will get to soon). So by inserting the eLearning toolbar
into the second template page, all of our topics, except the Home page, will include it in the output.

1. In the Content Explorer, expand Resources > Template Pages. Notice the two template pages.

2. Double-click Other-Topics.flmsp to open it.

CHAPTER 6  61



3. So far, this template page has two gray bars, which are proxies. We want to add a new proxy
at the bottom. On your keyboard, press the down key until you see the cursor flashing
horizontally after the second gray bar.

4. From the eLearning ribbon, select eLearning Toolbar Proxy.
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5. In the eLearning Toolbar Proxy dialog, you could select a skin component, if you have one.
But we don't have one yet, so we'll just leave this setting at (default). Click OK.

A new gray bar representing the eLearning Toolbar proxy is added to the template page.

6. Click to save your work.
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How to Add and Edit an eLearning Skin
Component
1. In the Project Organizer, right-click the Skins folder, and from the context menu select Add

Skin.
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2. In the Add File dialog, select HTML5 Component - eLearning Toolbar. In the File Name field,
enter eLearning (although in your actual project, you can name it anything you want). Then,
click Add.
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3. Expand the Skins folder to see the new file, and notice that the eLearning Toolbar Skin Editor
opens to the right. In the following image, the Setup tab is selected, but it's possible a
different tab might initially be active when you first open the editor.

4. On the left side of the editor, make sure the Setup tab is selected. Notice that three elements
(PreviousTopic, NextTopic, and ProgressBar) have already been added to the right side, and
will therefore be displayed in the output in just that order. We could remove any of these, or
change the order, but it's set just how we want, so let's leave it.

NOTE In the output, the "Next" button will automatically change to say "Complete"
when it is the final page of all quiz topics under a test node in the TOC.
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NOTE The progress bar will include all topics that are in the TOC. So if you have a
TOC with 2,500 topics and decide to insert a short course in the middle of it with an
eLearning toolbar that includes a progress bar, you might see something like "Page
943 of 2,500," which would look strange. Notice that in our own Flare online Help
output, we have not included the progress bar in our eLearning toolbar, because our
output has a small number of tutorials with knowledge checks compared to the rest
or our online Help system.

5. On the left side of the editor, select the Styles tab.

6. This gives us a preview of how the elements will look in the output. We'll leave most of the
look and feel as is, but let's change the color in the progress bar to match our orange
branding. To start, click the Highlight button in the local toolbar. This is a handy feature that is
going to help us quickly locate the style that we need to edit.
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7. Now that the Highlight button is enabled, click the blue progress bar in the preview. Doing this
automatically expands the Progress style group, selects the Inner Bar element, and displays
the style properties on the left.

8. Expand the Background property.

9. Next to the Color field, click for more colors. The Color Picker opens.

10. Select the Variables tab, and then select the primary branding color, var(--Primary). Click OK.
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Notice the progress bar is now orange. (The branding color in the skin is a CSS variable that is
pointing to the branding stylesheet.)

11. Let's change the font under that bar as well. Currently, it is a shade of blue. We could make it
orange like our progress bar, but that might be hard to read. So let's make it black. In the
preview, click Page 1 of 3. This expands the Progress style group, selects the Text element,
and displays the properties on the left.
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12. Expand the Font property.

13. Next to the Color field, click for more colors. The Color Picker opens.

14. Select the Variables tab, and then select the branding color, var(--Darkest). Click OK. The color
changes in the preview to black.

15. On the left side of the editor, scroll up if necessary and expand the Toolbar > Button style
group, and select (hover).

16. Expand the Background properties. The fields show the blue hex number.

17. Next to the Gradient field, click for more colors. The Color Picker opens.

18. Select the Variables tab, and then select the primary branding color, var(--Primary). Click OK.

NOTE When you generate the output, you'll notice that the navigation buttons have a
border around them when you hover over them. The skin component is using the
same blue color for the border that you just changed for the button hover
background. We're not going to change that color in this tutorial, but if you want to
change it for your own project, just expand the Border section (shown next to
Background in the image above) and change it in there for each of the fields shown
(Left, Right, Top, Bottom).

19. Click to save your work.
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CHAPTER 7

Creating and Developing
Targets
We're getting closer to producing some output, but first we need to create and develop some
targets, which are the files that actually generate the output. Our project already has two targets—
one intended for online output (using the necessary HTML5 format), and the other for PDF output.
But in this tutorial, we actually want to create three different online outputs—one that will include
the knowledge check and test topics (i.e., combination), a second that will include only the
knowledge check topics, and a third that will include only the test topics. Of course, all of these
outputs will also include the other regular topics containing information about the city of Austin,
Texas, but our goal for these three targets is to pinpoint which eLearning topics are shown.

This chapter discusses the following:

How to Rename and Develop the Combination Target 72

How to Develop the Knowledge Check Target 81

How to Develop the Test Target 84
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How to Rename and Develop the
Combination Target

Let's rename our existing online target so that it reflects our intention to create output combining
the knowledge checks and test.

1. In the Project Organizer, expand Targets.

2. Right-click All-About-Austin-HTML5, and from the context menu, select Rename.
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3. Type Combination-Course and press ENTER.

4. Double-click that target to open it.

5. We're going to leave a lot of the settings in the target just the way they are, but we want to
look at and edit a few things. On the left side of the editor, select the General tab.

CHAPTER 7  73



6. Notice that the Output Type field is set as HTML5, which is the most popular (and
recommended) target format for online output, and what you need in order to include an
interactive eLearning course. Also, from the Primary TOC field, make sure Online-TOC is
selected.

7. Select the eLearning tab.
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8. In this tutorial, we're not actually going to integrate the output with an external learning
management system (LMS). But for the moment, let's pretend that we will be doing that.
From the Standard field, select SCORM 2004.

NOTE SCORM 2004 is just one of the standards available. You can select a different
one from the field (i.e., SCORM 1.2 or xAPI) if you want.

9. For the Name, enter Austin Combination Course.

10. We could also provide a description and custom ID, but for this tutorial, let's just leave those
fields as they are.
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11. From the Tracking field, select Use Test Result. Because we have include a test node in our
TOC, this is the option we want, so that the external LMS uses the results from that quiz.

12. Select the Conditional Text tab.
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13. Here is where we finally make use of those conditions that we created and applied earlier. We
need to tell Flare which conditions should be included or excluded from the output generated
by this target. On the left side of the editor, select Default. Then, click the
CombinationCourseOnly row, and on the right side select Include. This sets the action for that
condition row.

14. For the KnowledgeCheck and Test condition rows, select Include.
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15. For the KnowledgeCheckOnly and TestOnly condition rows, select Exclude.

16. The PrintOnly and ScreenOnly condition rows are already set. The idea is that the PrintOnly
condition can be applied to content and files that should be included only in print-based
targets (such as PDF), and the ScreenOnly condition can be applied to content and files that
should be included only in online targets. Of course, you don't need to use these conditions in
your actual project if you so choose, or you can rename them and use them for another
purpose. The other three condition rows that are shown in this target are Mobile, Tablet, and
Web, which are intended to be used for responsive outputs. In other words, you can apply
these conditions to content so that the online content is displayed in a certain way, depending
on whether the learner is viewing it on a small, medium, or large screen. Currently, these are
not set, so by default they will be included in the output with no special circumstances. But
let's set them as intended, just in case you want to use those conditions on content in the
future.
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To begin, select the Mobile condition row, and on the right, select Display by Media Query,
then Mobile.

17. Select the Tablet condition row, and on the right, select Display by Media Query, then Tablet.

18. Select the Web condition row, and on the right, select Display by Media Query, then Web.

19. Select the Advanced tab on the left side of the editor.
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20. Scroll down and notice that the Template Page field is pointing to the Other-Topics template
page. This is how Flare knows to use that particular template page (which, in this case,
contains our eLearning Toolbar proxy) for most of the topics in the output. The only topic that
is using a different template page is the Home page (in that case, the Home-Page template
page is set in the topic properties for that file).

21. Click to save your work.
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How to Develop the Knowledge Check
Target

Most of the settings for our second output—which will display the knowledge check topics but not
the test topics—should be identical to those in the target we just edited. So the easiest thing to do in
this case is make a copy of the first target, rename it, and make a couple of tweaks.

1. In the Project Organizer on the left side of Flare, select the Combination-Course target file and
press CTRL+C on your keyboard. Then, press CTRL+V.

2. Right-click the copy of the target that is added, and from the context menu, select Rename.

3. Type Knowledge-Check-Course for its new name and press ENTER.
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4. In the same way, make a copy of that target and rename the new target Test-Course.

5. Double-click Knowledge-Check-Course to open that target.

6. Select the eLearning tab.

7. Change the Name field to Austin Knowledge Check Course.
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8. From the Tracking field, select Use Course Completion. This is different from the option we
chose in the previous target, because this output will not include a gradable quiz. We'll leave
the Percentage field set to 100, which means learners must complete the entire course.

9. Select the Conditional Text tab.

10. Change the settings so that they match the following image.

11. Click to save your work.
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How to Develop the Test Target
1. In the Project Organizer double-click the Test-Course target file to open it.

2. Select the eLearning tab.

3. Change the Name field to Austin Test Course. We'll leave the Tracking field as is
because this output will include the gradable quiz.

4. Select the Conditional Text tab.

5. Change the settings so that they match the following image.

6. Click to save your work.
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CHAPTER 8

Building and Viewing Output
Let's build and view some output to see how our additions and changes look and work.

This chapter discusses the following:

How to Build and View the Combination Course 86

How to Review the Combination Course Output 87

How to Fix the Spacing for the Submit Button 97

How to Build and View the Knowledge Check Course Output 100

How to Build and View the Test Course Output 103
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How to Build and View the
Combination Course
1. Open the Combination-Course target.

2. In the local toolbar, click Build.

3. In the Builds window pane at the bottom of Flare, double-click the row when you notice that it
has finished building successfully (a dark green cell is shown).
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How to Review the Combination
Course Output

Let's go through the course in the output to see all of the additions and changes that we've made in
this tutorial.

1. The Home topic is the first one that you see in the output, even though it wasn't included in
the table of contents (TOC). That's because it was already specified as the "Startup Topic" on
the General tab of the Target Editor.

Notice how this page has a different look and feel from the rest of the topics that we'll view as
we progress through the course. That's because it is using a different template page.
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First, it has the "hero" image behind the text "All About Austin."
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Second, it has a footer at the bottom of the topic with information about the company and
another instance of the logo.
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Third, there is no eLearning toolbar at the bottom of the text that lets you move to the next or
previous topic, or see the progress of the course.

Another thing to notice is the sentence just above the START COURSE link. It says, "There is a
knowledge check and a test later in this course." In the source topic, there are a couple of
other sentences, but we conditioned those out of this target, while including this sentence.

2. Click the START COURSE link.
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3. At the bottom of the topic, notice the toolbar with the buttons and progress bar. The
"Previous" button is disabled because this is the first topic in the table of contents (TOC) and
it is using the template page containing the eLearning Toolbar proxy. Also notice that the
color in the progress bar is orange, which we edited in the skin component to match the rest
of our branding.

Click Next, and notice the background color of the button, which we changed in the eLearning
Toolbar skin component.
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4. Both of the questions on this page were marked as required in the topic, so notice that the
Next button at the bottom is disabled until you answer both questions and click Submit.

The First Knowledge Check page is shown because we included that condition in the output
for this target. To refresh your memory, we had placed the "KnowledgeCheck" condition on
this entry in the TOC. Choose Austin as the answer for the first question, and click Submit.
The answer is correct, and the appropriate feedback displays.

NOTE The color and look of the selected circle can also be customized by using
styles in your regular stylesheet. We're not going to make that change in this tutorial,
but if you look at the stylesheet in one of the eLearning project templates that are
built in to Flare, you can see where this was done. If you open that stylesheet in the
Text Editor (rather than the regular Stylesheet Editor), you will see many custom
styles that were created under a section called /* eLearning */. These styles control
not only the look of selected circles and squares, but other things as well, such as
feedback content.
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5. Choose Long hot summers and Snowfall in autumn as answers for the second question.
Then, click Submit. Only one of those answers is correct, and the feedback indicates this.

Also, notice that the Submit button doesn't have any space between it and the toolbar below.
We'll fix this in a moment by adjusting the style in the stylesheet. But for now, let's keep
reviewing the output.
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6. Now that you've answered both of these required questions, the Next button is enabled in the
toolbar. Click Next.

7. At the bottom of the next few pages, click Next, until you get to the Second Knowledge Check.
Notice that the Next button at the bottom is enabled, because we marked both of the
questions in this topic as optional.

8. For each of the answers in the Second Knowledge Check, select answers and click Submit.
Then, click Next.

9. On the next page, click Next.

10. Now you see the first page of the Quiz. This topic is linked to the test node in the TOC, so all
of the topics that follow will be graded (because they're under the test node in the TOC). Click
Next.

11. For Question 1, select Stephen F. Austin and click Next. There is no Submit button here
because we do not want to show instant feedback.
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12. For Question 2, select "Center for Urban Bat Colonies", and click Complete.

The test results page immediately displays. We did not create this page in the project, so
Flare just used a default page. However, you have the option of creating and designing a
custom search results page if you want. One of the answers in the quiz was correct and the
other was incorrect, so the results page indicates a score of only 50%, which is fail, because
our pass percentage set in the test node is 75%.
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NOTE You can customize the look of the default test results page by adding a Test
Results skin component to the project and modifying the styles within it. For
example, if you wanted to change the text at the top to match the orange branding of
the rest of the output, you would change the font color for the Title style in the Test
Results Skin Editor.

NOTE In the knowledge check topics in this project, we included feedback text for
each question, accessed instantly by learners via the Submit button that we added.
Although you would not want to provide instant feedback for a gradable quiz, you can
still add feedback text for each answer, just as we did with the knowledge check
topics. However, by not including the Submit button at each of those locations, the
feedback text would simply be displayed in the final test results.
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How to Fix the Spacing for the Submit
Button

Before we continue with the other outputs, let's fix the spacing (or lack of it) below the Submit
button in the knowledge check topics.

1. In Flare, open the Second Knowledge Check.htm topic.

2. If your structure bars (the vertical rectangle blocks) are not shown to the left of the content,
click in the bottom toolbar.

3. Right-click the little structure bar to the left of one of the Submit buttons, and from the
context menu select Style Class > Edit Style Class.
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4. The Stylesheet Editor opens, with that style class selected automatically. Make sure the
options in the Stylesheet Editor are selected as shown by the rectangles in the following
image.
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5. In the properties area on the right side of the editor, expand Box.

6. In the field to the right of margin-bottom, enter 20px, and press ENTER.

7. Click to save your work.
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How to Build and View the Knowledge
Check Course Output
1. Open the Knowledge-Check-Course target.

2. In the local toolbar, click Build.

3. In the Builds window pane at the bottom of Flare, double-click the row when you notice that it
has finished building successfully (a dark green cell is shown).

4. In this output, you'll notice the same content, and many of the same features and design that
was shown in the Combination Course output. But right away, on the Home page, you'll notice
that the last paragraph before the START COURSE link is unique for this output. That's
because we used a condition to include it in this output and exclude it from the other outputs.

5. Click START COURSE.
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6. Just as you did in the previous output, move through the course, clicking Next and answering
questions. Along the way, notice that the spacing between the Submit button and the toolbar
looks better.
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The last page of the course is called "The End."

This particular topic is linked to an entry in the TOC, which is conditioned to show in this
output only. That's why you didn't see it in the Combination Course output, and you won't see
it in the Test Course output either. Also, the entire test section that was seen at the end of the
Combination Course is not in this course at all, because the Knowledge Check Course target
excludes the condition associated with that test node in the TOC.
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How to Build and View the Test
Course Output
1. In Flare, open the Test-Course target.

2. In the local toolbar, click Build.

3. In the Builds window pane at the bottom of Flare, double-click the row when you notice that it
has finished building successfully (a dark green cell is shown).

4. Once again, on the Home page, you'll notice that the last paragraph before the
START COURSE link is unique for this output, due to the conditions that we used in the
project.

5. Click START COURSE.

6. Click Next at the bottom of each page until you get to the Question 1 page.

7. Press F5 on your keyboard to refresh the page. Do this repeatedly and notice the order of the
answers changes each time. That's because we told Flare to randomize the quiz answers
each time the course is loaded again.
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NOTE Pressing F5 is just a way for you to test the output in order to see the
randomization. In a real quiz, learners won't need to press F5. This is just to show
that the order of the answers will vary each time the quiz is launched.

8. Answer the questions on these last pages, clicking Next and then Complete, which brings you
to the results page.

Notice that you did not see any knowledge check topics throughout the course, which were
conditioned out of this target.
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CHAPTER 9

Going Skinless
In all of the outputs that we've generated and viewed, there is navigation on the left side of the
output that provides links to all of the topics in the table of contents (TOC). In addition, there is a
search bar at the top.

All of this is included because our project is based on the Austin project template, which was
already set up to use a Side Navigation skin. However, you might not want to include this kind of
navigation.
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Also, remember that in our Knowledge Check Course, the test topics were not included, and in the
Test Course, the knowledge check topics were not included. However, that's not entirely true. They
were excluded from the navigation, but if you were to search for one of those supposedly excluded
topics, you would be able to open it. If you wanted to completely exclude a topic from a particular
output, you would need to place the condition on the topic file itself (or the folder containing it) in
the Content Explorer.

In your actual project, you might not want either the side navigation or the search capabilities. In
that case, you can create what is known as "skinless output." It is called this because you would not
be using a main skin (Side Navigation, Top Navigation, or Tripane) at all. However, you still might be
using smaller skin components, such as the one that we created for use with the eLearning toolbar.

There are a couple of ways to do this, including removing the main Side Navigation skin that is
providing the navigation and search bar. But we're going to do something quite simple, while
keeping our Side Navigation skin in the project.
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How to Remove the Navigation From
the Main Skin
1. In the Project Organizer, under the Skins folder, double-click Side Navigation to open it to the

right.
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2. In the Skin Editor, select the Setup tab. Then, from the Main Menu Position field select None,
and from the Slide-Out Position field, select None.
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3. Select the Styles tab. On the left side expand the Header style group, and select Search Bar.
Then, expand the Layout property, and set the Display field to none.

4. Click to save your work.
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5. Build and view the output again for the Combination Course target. The output for the Home
page now looks like this, with no side navigation and no header bar that includes the search
field.

6. Click START COURSE and navigate through the other pages to see that the navigation and
search bar are also hidden from them as well.
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NOTE There are many other ways to alter the look of your output. For example, you could
have a project without a main skin (e.g., Side Navigation, Top Navigation, Tripane)
altogether, but to include a header at the top of topics you could create a custom style,
insert your logo image in the template page above the Body proxy, and apply the style to
that area (probably to a <div> or <p> tag). That's how the same situation is handled in the
eLearning project templates that are built in to Flare.
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CHAPTER 10

Creating Print-Based Output
To this point, all of our output has been online. But let's say that you also want to generate some
print-based output from the same source files. The good news is that the Austin template we're
using is already set up for some PDF output. We just need to add our eLearning topics and make a
few other adjustments.

Let's create two different PDFs—one designed for a teacher (where the answers are shown), and
another for students (where the answers are hidden).

This chapter discusses the following:

How to Rename a Target 113

How to Create a Variable 117

How to Adjust Other Target Settings 121

How to Edit the Table of Contents (Outline) 123

How to Create a Subtitle Style 128

How to Edit the Title Page 131

How to Create a New PDF Target 134

How to Build and View the PDF Targets 138
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How to Rename a Target
1. In the Project Organizer, expand the Targets folder, right-click All-About-Austin-PDF, and

select Rename.
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2. Enter Combination-Course-Teacher for the new name of the target, and press ENTER.

3. Double-click that target to open it.
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4. Select the General tab. Notice that the Output Type is set as PDF. Also, from the Primary TOC
field, make sure Print-TOC is selected.

5. Select the Conditional Text tab.

6. This PDF is going to be the same as the online Combination Course, except that it is in PDF
format. So set the conditions to match the online target for the Combination Course, as
shown in the following image.

Notice that the Mobile, Tablet, and Web conditions are not explicitly set. That's because those
are intended for online output only, where the size of screen changes and affects the content.
In this case, we're creating PDF output, so these conditions aren't important to set.
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NOTE You could create additional conditions if there is content that you want to
separate for the teacher and student versions of the PDFs. However, we're not going
to do that in this tutorial. There are a couple of places where the PDFs will differ in
this tutorial. First, the subtitle will be different, and in one PDF the answers will be
shown while they will be hidden in the other PDF. But we're going to handle that using
a couple of other features, so we don't need any special conditions for those
purposes.

7. On the left side of the Target Editor, select Variables. There is an existing variable that we
want to use, and another variable that doesn't exist yet, so we'll create it below and then
come back to the target afterward.

8. Click to save your work.
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How to Create a Variable
1. In the Project Organizer, expand the Variables folder.

2. Double-click General (which is the only variable set file that we currently have in the project; it
contains all of the variables that we have so far). The Variable Set Editor opens to the right.

3. First, let's change the name of the existing variable that we want to use. In the grid, click
UserGuideTitle and press F2 on your keyboard.
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4. Replace the text with the more simple Title. Then, change the Definition cell to Austin
Combination Course, and press ENTER.

5. In the local toolbar, click . This adds a new row to the grid.
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6. Replace the NewVariable text with Subtitle, and in the Definition cell enter Teacher
Version.

7. Now we're going to do something really cool and create an alternative definition for that
variable. Select the Subtitle variable row, and in the local toolbar click .

CHAPTER 10  119



8. In the empty cell that is created, enter Student Version and press ENTER.

9. Click to save your work.

10. Go back to the Combination-Course-Teacher target, and look at the variables on the Variables
tab. Notice the new variable and the one that we renamed.
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How to Adjust Other Target Settings
There are obviously a lot of settings that we could change in our PDF target, but we'll focus on just
a couple more and then move on.

1. In the Target Editor, select the Advanced tab, and enable the option Show correct answers for
eLearning questions.
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2. Select the PDF Options tab, and replace the text in the Title field with Austin Combination
Course - Teacher Version. You can also replace the Author field text with your own
name if you want. These will not be shown on any of the PDF pages, but they will be reflected
in the PDF file properties.

3. Click to save your work.
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How to Edit the Table of Contents
(Outline)

We already have a table of contents (TOC) file in this project designed for PDF outputs, so we can
edit that and use it for both of our PDF outputs. Here is a very important thing to know, however:
The TOC file does not actually generate the TOC for print-based outputs such as PDF. Instead, it
functions more as an outline. When you generate a PDF target using that TOC file, Flare will stitch
all of the topics together that are linked in that TOC, and it will do so in the order that they appear in
the TOC Editor.

So what about the generated TOC in the output? There are a couple of ways to create that, and this
project is set up to generate the TOC automatically. If you go back to the Target Editor, you can see
this option on the Advanced tab.
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1. In the Project Organizer, expand the TOCs folder, and double-click Print-TOC to open it.

When we're done, this TOC (outline) will look much like the TOC being used for the online
outputs. Sure, we could actually use the same TOC for both online and PDF outputs, but in
this project we're separating them to make it clear what's going on. In your actual projects,
you will find that there are times that it makes sense to use a single TOC, but other times
when it's better to use multiple TOCs. A lot of that depends on how complex the TOCs can get
over time.

In our print TOC file, there is one entry at the very top (Title-Page) that is unique to this TOC.
This entry is connected to a print-only topic that we created; it is designed to show the first
page of the PDF.
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2. In the Content Explorer, expand the Knowledge-Check-Topics and Test-Topics folders. Then,
drag the topics to the TOC file as shown in the following image. Unlike the TOC for the online
output, however, this TOC does not need to have a test node, even though you are including
the test topics. That's because the test node's functionality only kicks in for online HTML5
outputs.
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3. Since we're dealing with pages in an PDF (which is often divided into chapters), instead of
online topics, we also need to tell Flare where to start new chapter breaks. At the same time,
we can specify which page layout to use for a particular entry in the TOC file. A page layout in
print-based output is used to control page size, configuration, headers, footers, pages
numbers, etc. To start, select the First Knowledge Check entry, and in the local toolbar click
.

4. In the Properties dialog, select the Printed Output tab. From the Break Type field select
Chapter Break, and from the Page Layout drop-down select Chapters. Then, click OK.
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5. Repeat this step for the Second Knowledge Check and Quiz entries in the TOC. However, do
not do it for Question 1 and Question 2, since they are not considered the start of new
chapters.

6. Click to save your work.
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How to Create a Subtitle Style
We already have a style that controls the look of the title for our PDF outputs, but because we're
adding a new subtitle, we want to create another style just for that.

1. In the Content Explorer, go to Resources > Stylesheets, and open the stylesheet.

2. On the left side of the Stylesheet Editor, select the p style.

3. In the local toolbar, click Add Selector.
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4. In the dialog, the HTML Element field is already set correctly. In the Class Name field, enter
Subtitle. Then, click OK. This adds the new style class to the stylesheet.
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5. With that new class selected on the left, go to the properties area on the right and expand
Font. Then, set the font-size to 28pt and the line-height to 30pt.

6. Click to save your work.
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How to Edit the Title Page
1. In the Content Explorer, expand the Print-Only Topics folder, and double-click Title-Page.htm

to open it.

2. Click at the end of Austin Combination Course (which is a variable inserted into the topic),
and press ENTER to create a new empty paragraph.
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3. In the local toolbar, click (the face of the button, not the down arrow).

4. In the dialog, select the Subtitle variable, and click OK. This adds the variable to the topic.
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5. With your cursor still located on the line where you inserted the variable, select the Home
ribbon at the top of Flare. Then, from the Style drop-down, select p.Subtitle. The size of the
variable text increases in the XML Editor.

6. Click to save your work.
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How to Create a New PDF Target
We already have our target for the teacher version of the PDF output. Now we just need a second
target for the student version. The easiest way to do this, since the two targets share so many
settings, is to make a copy of the first one.

1. In the Project Organizer, expand Targets.

2. Select Combination-Course-Teacher and press CTRL+C on your keyboard. Then press
CTRL+V.

3. Rename the copy of the target to Combination-Course-Student, and press ENTER.

4. Double-click that new target to open it.

5. Select the Variables tab.
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6. In the Subtitle row, click the down arrow and select Student Version.

7. Select the Advanced tab.
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8. Remove the check mark from the option Show correct answers for eLearning questions.

9. Select the PDF Options tab.
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10. Change the text in the Title field to Austin Combination Course - Student
Version.

11. Click to save your work.
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How to Build and View the PDF
Targets
1. In the local toolbar of the Combination-Course-Student target, click Build.

2. When the build finishes, double-click that row in the Builds window pane at the bottom of
Flare.

3. On the first page, notice the subtitle is using the Student Version variable definition. The
spacing between the wrapped title (Austin Combination Course) looks like it might be too
much, but you can fix that by adjusting the line height for that p.title style class.
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4. On the second page, notice the TOC was generated automatically, and the eLearning topics
were recorded as separate chapters, because we told Flare to do that.

5. On page 5, notice that the answers for the First Knowledge Check are not shown, only the
questions. If you scroll down, you'll see it's the same for the other knowledge check and the
quiz pages.
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6. Build and view the output for the Combination-Course-Teacher target.

7. Notice the subtitle on the first page is using the Teacher Version variable definition.
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8. On page 5 (and on the other pages where questions occur), notice that the answers are
shown.

9. Close the PDFs.

10. In Flare, we've opened a lot of files during the course of this tutorial. Let's close them all at the
same time. Select the Window ribbon at the top of Flare, and select Close All Documents.
Closing all of your files can help Flare to load faster next time if you have the application set
to always automatically load the last files that you had open in a project (File > Options >
General > Auto-Reload Documents).
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CHAPTER 11

Accessing the LMS Package
Earlier in this tutorial, we chose settings in the HTML5 targets (eLearning tab) to integrate the
output with an external learning management system (LMS). If you choose to do this with your own
output, you need to access the resulting LMS package ZIP file, which can then be uploaded to your
external LMS. Let's go find the package file that we generated for one of our HTML5 targets.
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How to Access an eLearning Package
1. From the Project ribbon at the top of Flare, click Open Output Folder.

2. In Windows Explorer, you will see folders for each of the targets where you have generated
output. Double-click the Combination-Course folder.

3. Double-click the LMSPackage folder to open it.
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4. Notice the ZIP file, which has the name that we provided for it in the target (Austin
Combination Course). This is what you upload to your LMS.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

Tutorials
Getting Started Tutorial

Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

MadCap Central Integration
Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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